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CHAPTER 10
GRITS SAGE

10.1 INTRODUCTION

The GRITS SAGE module offers the user a data entry alternative to the GRITS Database
module.  GRITS Database and GRITS SAGE are both editors for the same GRITS/STAT
database files (See Section 3.1.1).  GRITS SAGE allows you to edit your ground water data in a
spreadsheet-like fashion that allows you to see multiple wells, sampling dates and parameters on
the screen at the same time.  Figure 10-1 shows the same GRITS/STAT database files being
edited in GRITS Database module and GRITS SAGE.

The PROGRAM DATA EDITOR in GRITS Database The Spreadsheet screens in GRITS SAGE shows
(Section 3.5.1) shows one sampling date and one well at multiple sampling dates and wells.
a time.

Figure 10.1.  The PROGRAM DATA EDITOR in GRITS Database and the GRIT SAGE
Well, Date x Parameter Spreadsheet for the BENCHMARK Facility.

GRITS SAGE also offers a relatively straight forward ASCII Import option.  Unlike the Make a
Results Template and Read a Results Template options in GRITS Database (See Section
3.5.2), the Flat ASCII Import option of GRITS SAGE does not require Facility, Sampling
Dates, Wells and Parameters to be entered prior to importing and does not require Lotus® 1-2-3.
The ASCII file accepted by the Flat ASCII Import option may be created with a simple editor
(i.e., MS® DOS EDIT) or a commercially available spreadsheet program (i.e., Microsoft®
Excel).

Reports in GRITS SAGE were created with Concentric® R&R Report Writer.  R&R users may
freely modify the existing reports to suit their needs.
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Figure 10-2.  The GRITS SAGE Data System Main Menu.

10.2  STARTING GRITS SAGE

Follow the steps below to launch the GRITS SAGE module.

1. Start GRITS/STAT 5.0 (See Section 2.4).

2. Use the up and down arrow keys to highlight the GRITS SAGE option of the
GRITS Main Menu and press <Enter>.  The GRITS SAGE Data System
Main Menu should appear on your screen as shown in Figure 10-2.

GRITS SAGE may also be launched directly from the MS-DOS prompt.  This is useful if
you are running on a PC with low conventional memory.  Note that the GRITS Main
Menu (Figure 2-5) costs approximately 20KB of conventional memory to run.  To start
GRITS SAGE form the MS DOS prompt follow the steps below.

1. At the MS DOS prompt use the CD command to switch to the
\GRITS500\GRITSAGE directory on your hard drive.

Type <CD \GRITS500\GRITSAGE> and press <Enter>.

Your DOS prompt should look like this:

C:\GRITS500\GRITSAGE>_

2. Type <SAGE> and press the <Enter> key.  The GRITS SAGE Data System
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Main Menu should appear on your screen (Figure 10-2).

10.3 THE GRITS SAGE MENU

The GRITS SAGE menu tree is shown in Figure 10-3.  Menu items in GRITS SAGE may be
executed by using the up and down arrow keys to highlight the desired item and pressing
<Enter>.  You may also execute a menu item by pressing the item’s trigger key.  Trigger keys are
underlined in Figure 10-3.

Menu Item Action or Lower Menu Section

Q) Quit Exit GRIT SAGE.

1) System Utilities and Maintenance Q) Quit

C) Clean Up Databases Section 10.10

D) Create Empty GRITS Databases Section 10.5

2) Choose Directory Select a data directory. Section 10.4

3) Code Support Screens... Q) Quit

1) Facility Information Section 10.8.2

2) Wells Database Section 10.8.3

3) Parameters Database Section 10.8.4

4) Sampling Events Database Section 10.8.5

5) Master Parameter List Section 10.8.6

6) Well Casing Types Section 10.8.7

7) Well Log Codes Section 10.8.8

8) Units Code Support Section 10.8.9

9) EPA Method Codes Section 10.8.10

4) Well, Date x Parameter Spreadsheet Section 10.6

5) Date, Well x Parameter Spreadsheet Section 10.6

6) Parameter, Date x Well Spreadsheet Section 10.6

7) Date, Parameter x Well Spreadsheet Section 10.6

8) ASCII Import, Export... Q) Quit

1) SAGE ASCII Export Section 10.7.1.3

2) SAGE ASCII Import Section 10.7.1.5

3) Flat ASCII Import Section 10.7.2.3

4) Flat ASCII Export Section 10.7.2.4

9) Groundwater Reports... Q) Quit

1) Select Printer Section 10.9.1
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Figure 10-4.  The Data Directory Selection dialog.

2) Parameter, Date x Well Report Section 10.9.3

3) Well, Date by Parameter Report Section 10.9.4

4) Summary Statistics by Well (%ND<100) Section 10.9.5

5) Results by EPA Method Code Section 10.9.6

Figure 10-3.  The GRITS SAGE Menu tree.

10.4  SELECTING A DATA DIRECTORY

Prior to working on ground water data in GRITS SAGE you should check the currently selected
data directory.  The data directory in GRITS SAGE is independent of the data directory used by
the other GRITS/STAT modules.  Selecting a data directory in GRITS Database (See Section
3.3) does not set the data directory for GRITS SAGE.  Follow the instructions below to select
the data directory for GRIT SAGE.

1. Use the up and down arrow keys to highlight the Choose Directory option of the
Data System Main Menu (Figure 10-2) and press <Enter>.  The Data
Directory Selection dialog appears on your screen as shown in Figure 10-4.

2. The currently selected data directory is shown next to the Directory prompt
(\GRITS500\SEMINAR5\ in Figure 10-4).  If the desired data directory is
already selected press <Esc>.

To change the currently shown data directory type the letter of the drive the
desired data directory is on and press <Enter>.  A list of all directories on the
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Figure 10-5.  The Data Directory Selection dialog after directories on the hard drive have been
scanned.

drive is built and displayed in a list box under Directories as shown in Figure 10-5.

Note: Depending upon the size and content of your hard drive, scanning the
directories may take a few moments.

3. Use the up and down arrow keys to highlight the desired directory and press
<Enter>.

10.5  CREATING A NEW DATA DIRECTORY

The Create Empty GRITS Databases option of the System Utilities and Maintenance
menu may be used to create a new GRITS/STAT data directory.  To create a new data directory
follow the steps below.

1. From the GRITS SAGE Data System Main Menu use the up and down arrow
keys to highlight the System Utilities and Maintenance option and press
<Enter>.  The System Utilities and Maintenance Menu appears on your
screen as shown in Figure 10-6.
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Figure 10-6.  The System Utilities and Maintenance Menu.

Figure 10-7.  The NEW DATA DIRECTORY dialog.

2. Use the up and down arrow keys and highlight the Create Empty GRITS
Databases option and press <Enter>.  The NEW DATA DIRECTORY dialog
appears on your screen. (Figure 10-7).

3. Enter a valid MS-DOS directory name and press <Enter>.  A new directory will
be created on your hard drive and an empty set of GRITS/STAT database files
(Section 3.1.1) will be placed in the newly created directory.  The newly created
directory is automatically set as the currently selected data directory.

Example: A new data directory is desired for the XYZ Landfill.  At the Directory Name prompt
type:

<C:\XYZLAND> <Enter>.

10.6  GRITS SAGE SPREADSHEETS

GRITS SAGE offers four spreadsheet views of the data in the GRITS/STAT database files.  All
four spreadsheets work the same and use the same key strokes for navigation and editing.  The
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only difference between the four spreadsheet screens is the way in which the rows and columns
are ordered.  The four spreadsheet screens are shown in Figure 10-7.

Well, Date x
Parameter

Rows are sorted by Well, then Date.  Parameters form the columns.

Date, Well x
Parameter

Rows are sorted by Date, the Well.  Parameters form the columns.
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Parameter,
Date x Well

Rows are sorted by Parameter, then Sample Date.  Wells form the columns.

Date,
Parameter x
Well

Rows are sorted by Sample Date, then Parameter.  Wells form the columns.

Figure 10-7.  The GRITS SAGE Spreadsheet screens.

10.6.1 OPENING A SPREADSHEET

A GRITS SAGE spreadsheet contains data for one facility.  To open a GRITS SAGE
spreadsheet for an existing facility follow the steps below.  Note that data originally entered in
GRITS Database may be accessed this way.  To start a new spreadsheet see Section 10.6.2.

1. Select the data directory that contains the facility data you wish to edit (See
Section 10.4).

2. Use the up and down arrow keys to highlight one of the four spreadsheets on the
Data System Main Menu and press <Enter>.  The spreadsheet should appear on
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Figure 10-8.  Pop-up list of facilities in the \GRITS500\SEMINAR5 directory.

your screen (Figure 10-7).

3. If the desired facility does not appear next to the Facility prompt at the top of the
spreadsheet hold the <Alt> key down and press <F>.  The Facility prompt
becomes active.

4. Type all or part of the FCID of the desired facility and press <Enter>.  If you do
not type in the full FCID a pop-up list of facilities available in the currently
selected data directory will appear on your screen as shown in Figure 10-8.

5. Use the up and down arrow keys to highlight the desired facility and press
<Enter>.  The data for the newly selected facility will appear in the spreadsheet.

Note: To force the facility pop-up list to appear hold the <Alt> key down and press <F>. 
Hold the <Ctrl> key down and press <Y>.  Press <Enter>.

10.6.2 STARTING A NEW SPREADSHEET

A new spreadsheet may be started directly from any of the four spreadsheet screens.  To start a
new spreadsheet follow the steps below.  Starting a new GRITS SAGE spreadsheet is equivalent
to using the FILE DATA ENTRY MENU (Section 3.5) in GRITS Database to add Facility,
Sampling Dates, Parameters and Wells.

1. If you wish to create a new data directory follow the steps in Section 10.5.  If you
do not create a new data directory the new spreadsheet will be saved in the
GRITS/STAT database files in the currently selected data directory.

2. Start one of the four spreadsheet screen (Figure 10-7).  To start a spreadsheet
screen use the up and down arrow keys to highlight one of the spreadsheet options
on the Data System Main Menu (Figure 10-2) and press <Enter>.
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Figure 10-9.  The Add
Pop-up Menu

Figure 10-10.  The NEW FACILITY dialog.

3. Press <Insert>.  The Add Pop-up Menu appears on your screen as shown in
Figure 10-9.

4. Use the up and down arrow keys to highlight the Facility option and press
<Enter>.  The NEW FACILITY dialog appears on your screen (Figure 10-10).

5. The NEW FACILITY dialog allows you to enter up to ten wells, ten sample dates
and ten parameters.  If more wells, sample dates or parameters are required they
may be added individually through the Add Pop-up Menu (Figure 10-9) after
completing the entries in the NEW FACILITY dialog.  Table 10-1 details the
entries in the NEW FACILITY dialog.  The navigation, editing and toggle keys in
Table 3-3 are available in the in the NEW FACILITY dialog.

Entry Description

FACILITY ID The FACILITY ID or FCID is the standard, unique
RCRA facility identification code, If this is not a RCRA
facility, you may enter other standard codes that uniquely
identify the facility.
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Figure 10-11.  Well Gradient Pop-up.

Figure 10-12.  Sample
Dates and Duplicate Codes
column of the NEW
FACILITY dialog.

FACILITY NAME Enter the name of the facility.  If this is a permitted
facility use the name on the permit.

WELLS Enter up to 10 wells.  Each well entry consists of a Well
ID and Well Gradient.  Each Well ID should uniquely
define a Well at the Facility.

The Well Gradient entry for each Well is validated
against the Well Gradient Pop-up (Figure 10-11).

Valid Well Gradient code are:

<U> Upgradient Well
<D> Downgradient Well
<O> Other
<  > Unknown or not specified

If an invalid entry is made the Well Gradient Pop-up will
appear.  Use the up and down arrow keys to highlight the
desired Well Gradient and press <Enter>.

SAMPLE DATES Enter up to 10 Sample Dates.  Each Sample Date entry
consists of a Sample Date and Duplicate Code.

Valid Duplicate Codes are:

<A> Duplicate A
<B> Duplicate B
<C> Duplicate C
<D> Duplicate D
<W> CME A
<X> CME B
<Y> CME C
<Z> CME D
<  > Not a Duplicate
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Figure 10-13.  The Master Parameter List pop-up.

Figure 10-14.  The Select Search Criteria dialog.

Figure 10-15.  The Find dialog for the Parameter
Name search criteria.

Figure 10-16.  The Units pop-up list.

PARAMETERS Enter up to 10 Parameters.  Each parameter entry
consists of a Parameter Code, Replicate Code, Units and
Default Detection Limit.

Parameter Codes are validated against the Master
Parameter List.  If an invalid Parameter Code is entered
the Master Parameter List pop-up (Figure 10-13)
appears on your screen. Use the <88>, <99>, <Page Up>
and <Page Down> keys to highlight the desired
parameter.

Parameters may also be located in the Master
Parameter List pop-up with a search.  Press <F5> for
the Select Search Criteria dialog (Figure 10-14).  The
Master Parameter List pop-up may be searched by
one of the following:

Parameter Code
Parameter Name
CAS Number

Use the up and down arrow keys to highlight the desired
search criteria and press <Enter>.  The Find dialog
appears on your screen (Figure 10-15).  Type in the
Parameter information you are looking for and press
<Enter>.  The closest parameter in the Master
Parameter List pop-up will be highlighted.  Use the up
and down arrow keys to refine the search if necessary.

When the desired parameter is highlighted press
<Enter>.

Type in the Replicate Code (if any) and press <Enter>.

Type in the Units that observations are to be recorded in
and press <Enter>.  Units are validated against the
Units pop-up list (Figure 10-16).  Use the up and down
arrow keys to highlight the desired measurement units
and press <Enter>.

Type in the Detection Limit and press <Enter>.

Table 10-1.  NEW FACILITY dialog entries.

6. Use the up and down arrow keys to navigate between entries.  When you have
completed data entry in the NEW FACILITY dialog press <Page Down>.  The
new spreadsheet is setup and ready for data entry.  Figure 10-17 shows entries in
the NEW FACILITY dialog and the resulting spreadsheet that appear after the
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<Page Down> key is pressed.

NOTE:  Spreadsheets created in one of the four spreadsheet screens will automatically work in all
GRITS SAGE spreadsheet screens.  For example a spreadsheet were created under the Well, Date
x Parameter spreadsheet is automatically available in the other three spreadsheet screens.  Also,
a facility setup in GRITS SAGE may be edited in GRITS Database and vice-versa.

Figure 10-17.  The NEW FACILITY dialog and resulting spreadsheet.

10.6.3 SPREADSHEET DATA ENTRY
Table 10-2 lists the spreadsheet editing and navigation keys.
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Figure 10-18.  The Search
Criteria pop-up list.

Navigation Description
Keys

<88> Move to the cell above.

<99> Move to the cell below.

<66> Move to the cell to the right.

<77> Move to the cell to the left.

<Page Up> Move one page up.

<Page Down> Move one page down.

<F5> Search.  The Search option will jump to a specified well, date or
parameter in the spreadsheet.

Follow the instructions below:

1. Press <F5>.  The Search Criteria pop-up list appears as
shown in Figure 10-18.

Highlight the desired search criteria and press <Enter>.  A
pop-up Find dialog will appear on your screen.  Type in the
Well, Parameter or Sample Date that you wish to go to in the
spreadsheet and press <Enter>.  The cell will move to the
first row and column that matches the search criteria.

Editing Keys Description

<Enter> Toggles editing on and off for currently highlighted cell.

<Delete> Deletes the observation in the current cell.
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<Alt> <Delete> Deletes a spreadsheet row or column.  Use the Navigation Keys to
move to a cell in the row or column you wish to delete.  Hold the
<Alt> key down and press <Delete>.

A pop-up menu will appear and list the Well ID, Sample Date and
Parameter for the current cell.  Highlight the Well ID, Sample Date or
Parameter you wish to delete and press <Enter>.
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Figure 10-19.  The Add Well dialog.

Figure 10-20.  The Add Parameter dialog.

<Insert> Add a new Facility, Well, Sample Date or Parameter

Press <Insert>.  The Add Pop-up Menu appear on your screen
(Figure 10-9).  The Add Pop-up Menu allows you to add a new
Facility, Sample Date, Well or Parameter.  Use the up and down arrow
keys to highlight the item you wish to add and press <Enter>.  Follow
the instructions below.

Facility
Follow the instructions in Section 10.6.2.

Well
The Add Well dialog appears on your screen as shown in Figure 10-
19.

Type the Well ID and Gradient of the well you wish to add.  Press
<Enter> after typing the Gradient.  The new well will be added to the
spreadsheets and the Wells Database.

Parameter
The Add Parameter dialog appears on your screen as shown in
Figure 10-20.

The Parameter is validated by the Master Parameter List pop-up
(Figure 10-13 in Table 10-1).  Specify the Parameter, Replicate Code,
Measurement Units, Detection Limit and Report Order of the
parameter you wish to add.  The Report Order is a numeric entry that 
sets the ordering of the Parameters in the spreadsheet screens and
reports.  Press <Enter> after typing in the Ret. Order.  The new
parameter will be added to the spreadsheets and the Parameters
Database.
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<Shift> <88> Highlight a block of cells for Cut, Copy and Paste operations.

<Shift> <99>

<Shift> <77>

<Shift> <66>

<Shift> <Delete> Cut the currently highlighted cells to the GRITS SAGE clipboard.

<Shift> <+> Copy the currently highlighted cells to the GRITS SAGE clipboard.

<Shift> <Insert> Paste the contents of the GRITS SAGE clipboard to the current cell
location.
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Figure 10-22.  Lead data from well BW-1 for sample dates 1/1/92 to
5/1/92 is highlighted.

Figure 10-23.  The combined Histogram-Box Plot.

<Alt> <H> Creates a combined Histogram-Box Plot from the data in the GRITS
SAGE clipboard.  Follow the instructions below.

1. Highlight the block of cells that you want to produce a
combined Histogram-Box Plot on by holding the <Shift> key
down and pressing the arrow keys (Figure 10-22).

2. Hold the <Shift> key down and press the <+> key to copy the
highlighted data to the GRITS SAGE clipboard.

3. Hold the <Alt> key down and press <H>.  The combined
Histogram-Box Plot appears on your screen as shown in
Figure 10-23.

4. Press <Enter> to return to the spreadsheet screen.

Table 10-2.  Spreadsheet navigation and editing keys.

10.7  ASCII IMPORT/EXPORT FILES
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Figure 10-24.  The ASCII Import, Export Menu.

The ASCII Import, Export option of the GRITS SAGE Data System Menu supports
importing and exporting two ASCII file formats:

C SAGE ASCII File
C Flat ASCII File

Both ASCII file formats can easily be created with a simple text editor (i.e., MS DOS EDIT) or
an off-the-shelf spreadsheet (i.e., Microsoft® Excel).  The ASCII Import, Export Menu (Figure
10-24) contains options to export ground water data from the GRITS/STAT database files to the
two ASCII file formats and import data into the GRITS/STAT database files from the two
ASCII file formats.

Unlike the Make a Results Template (Section 3.5.2.1) and Read a Results Template
(Section 3.5.2.2) options of GRITS Database, the ASCII Imports in GRITS SAGE do not
require that facility information, wells, sample dates and parameters be entered prior to importing. 
 A Facility can be created in an ASCII file and the GRITS SAGE importing routines will create
the proper entries in the GRITS/STAT databases.

10.7.1 GRITS SAGE ASCII IMPORT/EXPORT

The SAGE ASCII file is imported and exported by the SAGE ASCII Export and SAGE ASCII
Import options of the ASCII Import, Export Menu (Figure 10-24).  The format of the SAGE
ASCII file is shown in Figure 10-25.  The SAGE ASCII file is limited to observations from one
parameter, but, the SAGE ASCII file format is useful for performing further analysis in
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commercial spreadsheet packages.

Note:  The Flat ASCII file (Section 10.7.2) is more flexible than the SAGE ASCII file for
importing data and permits multiple parameters in the same ASCII file.

“FCID:”, FCID

“NAME:”, Facility Name

“PARAMETER:”, Parameter Code

“REP CODE:”, Replicate Code

“UNITS:”, Units

“DETECTION LIMIT:”, Default Detection Limit

“ACL:”, ACL

“MCL:”, MCL

“DATE” “DUP CODE” ...Well ID 1 Well ID 2

“GRADIENT:”, “ ”, ...Gradient 1, Gradient 2,

Date 1 Dup Code 1, Obs , Obs ,Well1,Date1 Well2,Date1

Date 2 Dup Code 2, Obs , Obs ,Well1,Date2 Well2,Date2

Date 3 Dup Code 3, Obs , Obs ,Well1,Date3 Well2,Date3

... ... ... ... ...

Figure 10-25.  The SAGE ASCII import file.

The SAGE ASCII import file requires the use of keywords (i.e. FCID:, NAME:,
PARAMETER:, etc.).  The required keywords are shown as bold in Figure 10-25.

10.7.1.1  Creating a SAGE ASCII file with MS DOS EDIT

A SAGE ASCII file can be easily created with the MS DOS EDIT utility.  The
instructions in this section assume a basic knowledge of the MS DOS EDIT utility.  For
more detailed information on the MS DOS EDIT utility consult your MS DOS Manual.

1. From the DOS prompt start the MS DOS EDIT utility. Type:

<EDIT> <Enter>

The MS DOS EDIT utility should appear on your screen as shown in Figure 10-
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Figure 10-26.  The MS DOS EDIT Utility.

Figure 10-27.  The SAGE ASCII file for Benzene from the ground water report in Figure 3-2.

26.

2. Type in the contents of the SAGE ASCII file.  Use Figure 10-25 as a template. 
Enclose the keywords and data in quotes (“”).  Separate entries with commas (,). 
Figure 10-27 shows the SAGE ASCII file for Benzene from the ground water
report for ABC Landfill (Figure 3-2).
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Figure 10-28.  The MS DOS
EDIT File pull-down menu.

Figure 10-29.  The MS DOS EDIT Utility Save As dialog.

Note that Nondetects are preceded with a less-than sign (<) and enclosed in
quotes.

3. Hold the <Alt> key down and press <F>.  The File pull-down menu should
appear as shown in Figure 10-28.

4. Press <S> to execute the Save option of the File pull-down menu.  The Save As
dialog appears on your screen as shown in Figure 10-29.
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Figure 10-30.  A blank Microsoft® Excel spreadsheet.

5. Type in a legal MS DOS filename and press <Enter>.

6. Hold the <Alt> key down and press <F>.  The File pull-down menu will appear. 
Press <X> to exit the MS DOS EDIT Utility.

10.7.1.2  Creating the SAGE ASCII file with Microsoft® Excel

The SAGE ASCII file can be created with most off the shelf spreadsheet packages. 
Instructions are presented in this section are for Microsoft® Excel, however, a similar
process should work in other commercial spreadsheets.  The instructions below assume a
basic knowledge of Microsoft® Excel.  For more detailed information consult your
spreadsheet software manual.

1. Start Microsoft® Excel.  Double-click the Excel icon .  A blank Excel

worksheet should appear on your screen as shown in Figure 10-30.

2. Type in the contents of the SAGE ASCII file.  Use Figure 10-25 as a template. 
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Figure 10-31.  The SAGE ASCII file for Benzene from the ground water report in
Figure 3-2.

Figure 10-31 shows the Benzene data from the ground water report in Figure 3-2.

3. Hold the <Alt> key down and press <F>.  The File pull-down menu should
appear as shown in Figure 10-32.
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Figure 10-32.  The File pull-
down menu in Microsoft® Excel.

Figure 10-33.  The Save As dialog in Microsoft® Excel.

4. Press the <A> key.  The Save As dialog appears on your screen as shown in
Figure 10-33.

5. Choose the CSV (Comma delimited) (*.csv) option of the Save as type
combo-box as shown in Figure 10-33.
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Figure 10-33.  Message box that appears in
Microsoft® Excel when saving a CSV file.

6. Enter a valid MS DOS filename in the File name control and press <Enter>.  The
message box shown in Figure 10-33 appears on your screen.

Note: If possible save the CSV file to the \GRITS500\GRITSAGE directory. 
This will save you time and effort in looking for the file during the SAGE ASCII
Import session.

7. Press <Enter> or click the OK button.  Hold the <Alt> key down and press <F>. 
The File pull-down menu appears (Figure 10-32).  Press <X>.  A message box
appears on your screen and asks if you want to save your changes.  Press <Enter>
or click the OK button.

10.7.1.3  SAGE ASCII Export

The SAGE ASCII Export option of the ASCII Import, Export menu exports
observations for a user-selected parameter to a SAGE ASCII file.  This is helpful if you
wish to analyze data for a given parameter in an off-the-shelf spreadsheet package.

Follow the instructions below to export GRITS/STAT data to a SAGE ASCII file.

1. Use the up and down arrow keys to highlight the ASCII Import, Export... option
of the Data System Main Menu (Figure 10-2) and press <Enter>.  The ASCII
Import, Export Menu appears on your screen as shown in Figure 10-24.

2. Use the up and down arrow keys to highlight the SAGE ASCII Export option of
the ASCII Import, Export Menu and press <Enter>.  The ASCII EXPORT
dialog (Figure 10-34) appears on your screen.
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Figure 10-34.  The ASCII EXPORT dialog.

Figure 10-35.  The Facility pop-up list for the \GRITS500\SEMINAR5 data
directory.

3. Press <Enter>.  A pop-up list of facilities in the currently selected data directory
appears on your screen (Figure 10-35).  Use the up and down arrow keys to
highlight the Facility that you want to export ground water data from and press
<Enter>.  The cursor will advance to the Parameter entry.

If the desired facility does not appear it is probably in another data directory (See Section
10-4).
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Figure 10-36.  The pop-up list of parameters
monitored at the BENCHMARK facility.

Figure 10-37.  The nondetects options for the Flag NDs with <? prompt.

4. Press <Enter>.  A pop-up list of parameters monitored at the selected facility
appears (Figure 10-36).  Use the up and down arrow keys to highlight the desired
parameter and press <Enter>.  The cursor will advance to the Flag NDs with<?
prompt.

5. Press <Enter>.  The pop-up shown in Figure 10-37 appears.

Select the Y - Use < to flag Nondetects in ASCII Export File to export
nondetects as “<DL” where DL is the detection limit used for the observation.

Select the N- Write Nondetects as one-half observation detection limit to
export nondetects as ½DL where DL is the detection limit used for the
observation.  This is useful if you want to do some number-crunching in another
package and want to treat nondetects as observations with a value equal to one-
half the observation detection limit.  (This is how nondetects are handled in the
GRITS Statistics modules).

Use the up and down arrow keys to highlight the desired option and press
<Enter>.  The cursor advances to the File Name prompt.
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6. Type in a legal MS DOS file name and press <Enter>.  A SAGE ASCII file is
generated in the \GRITS500\GRITSAGE directory.

Note: Use a CSV, TXT or PRN extension when naming your SAGE ASCII file.

10.7.1.4 Loading a SAGE ASCII file in Microsoft® Excel

This section contains instructions for loading a SAGE ASCII file in Microsoft® Excel
Version 7.  While the instructions are specific to Excel, there should be a similar
procedure in other spreadsheet packages.

1. Start Microsoft® Excel.

2. Hold the <Alt> key down and press <F> or click the File menu.  The File pull-
down menu (Figure 10-32) should appear.

3. Press <O> or click the Open... option of the File menu.  The Open dialog
(Figure 10-38) appears on your screen.

Select the \GRITS500\GRITSAGE folder in the Look in combo-box.

Select Text Files (*.prn, *.txt, *.prn) in the Files of type: combo-box.

Double-click the SAGE ASCII file that you want to open.  The Text Import
Wizard dialog (Figure 10-39) appears on your screen.
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Figure 10-38.  The Open dialog in Microsoft® Excel.

Figure 10-39.  Step 1 of the Text Import Wizard dialog.

4. Click the Delimited radio button in the Original Data Type group box and click
the Next > button.  Step 2 of the Text Import Wizard dialog will appear on your
screen (Figure 10-40).
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Figure 10-40.  Step 2 of the Text Import Wizard.

5. Check the Comma option in the Delimiters group box and click the Finish
button.  Data from the SAGE ASCII file populates the spreadsheet cells as shown
in Figure 10-41.

6. Once the data is loaded in the spreadsheet, it may be analyzed or formatted for
publication quality.  For instructions on formatting and analyzing data see your
spreadsheet’s documentation.
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Figure 10-41.  Data from a SAGE ASCII file loaded in a Microsoft® Excel spreadsheet.

10.7.1.5 SAGE ASCII Import

The SAGE ASCII Import option of the ASCII Import, Export menu is used to import
data from SAGE ASCII files into the GRITS Databases in the currently selected directory. 
To import an existing SAGE ASCII file follow the steps below.  For information on
creating SAGE ASCII files see sections 10.7.1.1 and 10.7.1.2.

1. At the GRITS SAGE Data System Main Menu (Figure 10-2) use the up and
down arrow keys to highlight the ASCII Import, Export... option and press
<Enter>.  The ASCII Import, Export Menu (Figure 10-24) appears on your
screen.

2. Use the up and down arrow keys to highlight the SAGE ASCII Import option and
press <Enter>.  The File Selection pop-up appears as shown in Figure 10-42. 
Table 10-3 describes the key strokes used in the File Selection pop-up for
choosing a file to import.


